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Navigation Tips for the Web Time Sheet 
 

1. Use Internet Explorer or Netscape. 
2. To adjust font size in Internet Explorer select Text Size from the View menu.  

To adjust font size in Netscape select Increase/Decrease Font from the View 
menu.  

3. Use the Navigation Buttons on the time sheet not the browser back/forward 
buttons. 

4. Use the scroll bars on the right and bottom of your screen to move up or down. 
5. Your cursor will change from an arrow to a hand when you are in a field that 

allows data entry. 
6. Single click only. 
7. Web time sheet displays one week at a time beginning with the first day of a pay 

period, which may not be a Monday.  Use the Next button to move ahead one 
week. 
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Accessing your time sheet 
Electronic time sheets are located on the Employee Web and may be accessed  from any PC 
or Mac computer with an internet connection.  Open a time sheet by  clicking on Employee 
Web on the Human Resources home page or by selecting Faculty & Staff on Western’s 
home page then clicking WWU Information system.  

Log into the Employee Web 

At the User Login page enter your Western ID, also known as your W number.  The ID is 8 
digits preceded by a capital W.  Then enter your PIN, the PIN number is six digits, usually 
the first 6 digits of your SSN. 

 

 
 

. 

Select  Employee 
from the Main 
Menu 

Enter your WWU ID and PIN.  If 
you need assistance with your PIN 
contact the Admin Computing Help 
desk at x2853. 
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Next Select Time 
Sheet.   
 

 

The Position 
Selection page 
opens.   
 
 

 

Open a Time Sheet 

 The Position Selection page lists all positions available for time entry in the current pay 
period.  If you have more than one active position click on the radio button next to the 
position for which you will enter time. Click the Time Sheet button to open your time sheet.  
Time sheets from two previous pay periods may be viewed by clicking on the drop down 
box in the Pay Period and Status section. 

 

This section lists 
your job title, 
job number 
department and 
organization 
code.

Click here to open your 
time sheet. 
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Electronic Time Sheet 

A time sheet opens, the top portion displays your Title and Position Number, Department & 
Organization code, Time Sheet Period and Submit by date and time: 

 
 
 
 
 
 

The middle section is the earning section.  Time is entered in this section.  Depending on 
your employee class and whether you are hourly or salaried your time sheet may look 
different. 

 
 

The bottom portion contains navigation buttons, the submit button and approver 
information. 

 
 

Dates are listed across the top and 
earn/leave codes on the left

Note: Time can not be 
submitted after  the Submit 
date/time. 
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Enter Time 
There are two methods for entering time: one for hourly and student employees and one for salaried 
employees.  If you are an hourly or student employee, follow the instructions which begin below.  If 
you are a salaried employee, follow the instructions under the section titled Salaried Staff.  All staff 
may use the features described under the Optional Features section. 

Hourly Staff  

To begin entering time select a time sheet from the Position Selection Page.  Only time sheets for the 
current pay period with a transaction status of “Not Started”, “In Progress” or “Returned for 
Correction” are available for time entry.  All other time sheets are view only.   
Hourly staff are required to record time in/out for each day worked.  A time sheet is submitted each 
pay period in which hours are worked in order to be paid. 
Use the Hourly Regular Pay earnings code to record all regular hours worked.  Move your cursor 
to Hourly Regular Pay then across to the date to which you will enter time.  When your cursor 
changes to a hand click once.  Use Overtime Pay to record any overtime hours. 

 
 

Place the cursor on Enter 
Hours.  When the cursor 
changes to a hand click once. 
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The time in/out screen opens.  This screen is used to record the start and end time for hours worked 
each day.  The format for entering time is  HH:MM.  Minutes are rounded to the nearest quarter 
hour, example 2:35 is rounded to the nearest quarter hour and entered as 2:30. You will receive an 
error message if hours are not entered in this format. Be sure to indicate AM or PM.  The example 
below displays time in/out entries for a work day beginning at 8:00AM and ending at 5:30PM with a 
1 hour lunch: 
 

 

Enter time in/out for hours worked 
paying careful attention to the AM/PM 
field.  You should enter time daily for 
each day worked.  
 
If working beyond midnight enter Time 
Out as 12:00AM.  Save.  Click Next 
Day and enter Time In as 12:00AM. 
 
 
 
 
 
 
 
 
 
 
 
After hours are entered press Save. 
 

  

The hours worked for each segment of 
the day and the total hours worked for 
the day will appear in the Total Hours 
column.     
 
 
 
 
 
 
 
Options are: 

1. Next Day to move one day 
forward and enter more hours. 

2. Copy to copy hours 
3. Timesheet to return to the 

timesheet screen. 
 
The time sheet displays 8.5 hours for 
Mon. Feb 02, 2004 
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Click preview to view all time entered 
for the pay period. 
Preview displays the sum total of hours 
worked per day and the time in/out 
detail. 

 
 

Copy Hours 

The Copy Hours function is useful if you work the same hours more than one day.  To use this 
feature, first follow the directions to enter and save hours in the time/in out screen. 

  

 
 
 
To copy time in and out to 
another day click Copy. 
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The Copy Hours screen 
opens.  
Select “Copy from date 
displayed to the end of 
the pay period..” 
 

OR 
 

Select specific days to 
copy hours. 

  

 

For this example hours 
from Feb 02 are copied 
to Tuesday, Thursday 
and Friday. 
 
 
 
 
 
 
 
Click Copy. 
Click Time Sheet. 
 

 Copied hours are now 
displayed on the main 
time sheet screen.  Click 
the Preview button to 
view all hours entered 
for the pay period. 

Preview now shows a 
total of 32 Regular 
hours entered and the 
time in/out for each day 
worked is displayed. 
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Hours from a previous pay period 

Hours that did not get recorded in a previous pay period are recorded in the current pay period using 
the Late Hourly Time earning code.  Enter the sum total of hours in the first day of the pay period, 
enter the actual date and times of the hours worked in the comments box. 
Example: 18 hours from last pay period are entered on the current pay period time sheet.  

Move your cursor down to Late 
Hourly Time then across to the first 
day of the pay period, in this case Sun 
Feb 1.  When the cursor changes to a 
hand click once. 

 

Use the time in/out window to 
record all of the hours in the previous 
pay period.  If you need to enter more than 
24 hours Late time use more than one day. 
Click Save Hours 
Click Timesheet  

Next click Comments at the bottom 
of the timesheet. 

Enter the dates and times the hours 
were actually worked. worked. 
Click Save 
Click Previous Menu 
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Shift Differential  

WWU pays .50/hour for shift differential in addition to your base salary.  Shift Differential is 
different from overtime.  Keying time for Shift differential is a two step process; first use the Regular 
Hours earning code to enter the total amount of hours worked.  Second use the Hourly Shift 
Differential earning code to record the hours which you will be paid shift difference.  If you just 
enter shift difference without Regular hours you will only be paid 50 cents an hour. 
Example: Tuesday February 10th   you worked 8 hours from 10:00AM – 7:00PM with a 1 hour lunch.  
Two of the hours worked are eligible for Hourly Shift Differential. 

 
 

Step 1 Enter hours worked: Move 
your cursor down to Hourly Regular 
pay then across to the correct day.  
When the cursor changes to a hand 
click once.  The time in/out screen 
opens.  Enter all the hours worked for 
the day.   
Click Save Hours. 
Click Timesheet. 
 

8 hours Hourly Regular Pay are 
recorded. 

Step 2: Enter Shift Differential: Move 
your cursor down to Hourly Shift 
Differential Pay and across to the 
correct day.  When your cursor 
changes to an hand click once. 
Enter 2 in the Hours/Units Field.  
Click Save Hours/Units. 
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Two hours Shift Differential is 
recorded on Mon March 17 in 
addition to 8 Hourly Regular Pay. 

Submit Time Sheet for Approval. 

 
Time sheets need to be submitted for 
approval before the Submit by date 
and time listed at the top of the time 
sheet . 

 
Before submitting your timesheet for approval: 

• Click on Preview to view all entries and comments for the entire pay period. 
• Verify: 

 All hours worked were entered. 
 Regular Hourly Pay earning code was used for all regular hours worked. 
 Time in/out hours correct 
 Hourly Overtime Pay was used to record overtime worked. 
 Hourly Shift Differential Pay is accompanied by Hourly Regular Pay. 

 
• If you notice any errors after your time sheet is submitted for approval contact the person in the “Waiting 

for approval by” field at the bottom of your time sheet. 
 
 After you have verified that all time is entered 

correctly, click the Submit button at the bottom 
of your time sheet. 
 
If there is no submit button then 
• You have already submitted your time sheet 
• You are past the deadline for submitting time. 
In either case, contact your supervisor. 

 

Enter your 6 digit PIN number to certify your 
time sheet.  This is equivalent to a pen and ink 
signature.  
Click Submit 

Confirmation that your time sheet was 
submitted.  If you do not see this message your 
time sheet was not submitted. 
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Salaried Staff 
Salaried staff are required to submit a time sheet only if there are leave or exception hours to report.  
If you did not take any leave or earn exception time no time sheet is submitted, you are automatically 
paid normal hours. 
 

Enter Hours 

To begin entering time select a time sheet from the Position Selection Page.  Only time sheets for the 
current pay period with a transaction status of “Not Started”, In Progress” or “Returned for 
Correction” are available for time entry.  All other time sheets are view only.   
 

In the main time sheet screen select 
an Earning code on the left then 
move your cursor across to the date 
to which you will enter hours.  
When the cursor changes to a hand 
click once. 

 

Enter the total number of hours for 
the day rounded to two decimal 
places in the Hours/Units field.  
• Click Save   

or 
• Click Copy to copy hours to 

other days in the pay period. 

Copy Hours 

In the copy hours screen select 
• Copy from date displayed 

to the end of the pay 
period. 

 
Or 

• Select specific days to copy 
hours. 

 
Click Copy. 

 

Confirmation that hours were 
copied successfully. 
Click Timesheet. 
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Exception/Leave Hours from a Previous Pay Period 

Exception and leave hours that did not get recorded in a previous pay period are recorded in the 
current pay period using the correct leave code.  The sum total of leave hours are entered in the first 
day of the current pay period.  The actual dates and leave hours are recorded in the comments box. 
Example: 80 vacation hours taken in the previous pay period are recorded on the first day of the 
current pay period. 

Move your cursor down 
Vacation Leave then across to 
the first day of the pay period.  
When the cursor changes to a 
hand click once. 
 
Enter the lump sum of hours 
in the Hours field. 
 
Click Save 

Enter appropriate comments 
to explain your entries.  Verify 
with your supervisor as 
department requirements may 
differ. 
Click Save 
Click Previous Menu 

 

Submit Time Sheet for Approval. 

 
Before submitting your timesheet for approval: 

• Click on Preview to view all entries and comments for the entire pay period. 
• Verify all leave hours taken and/or exception hours earned are entered. 

 
• If you notice any errors after your time sheet is submitted for approval contact the person in the “Waiting 

for approval by” field at the bottom of your time sheet. 
 

After you have verified that all time is 
entered correctly, click the Submit button at 
the bottom of your time sheet. 
 
If there is no submit button then 
• You have already submitted your time 

sheet 
• You are past the deadline for 

submitting time. 
In either case, contact your supervisor. 
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Enter your 6 digit PIN number to certify 
your time sheet.  This is equivalent to a pen 
and ink signature.  
Click Submit 

 

Confirmation that your time sheet was 
submitted.  If you do not see this message 
your time sheet was not submitted. 

 
 
Optional Features 
 

Preview 

A helpful way to review your time sheet for errors or omissions prior to submitting is the preview 
feature.  Clicking on the preview button will display all the days in the pay period and only those 
earn/leave codes you have entered hours for.  In addition hourly employees will see the time in/out 
breakdown for each day worked.  Preview also displays comments. 

 
 

Print your Time Sheet 

While in Preview mode you may print your time sheet.  To print from Internet Explorer select Print 
from the File menu, select Layout, change the orientation to Landscape.  If your printer allows, select 
legal to print on legal size paper, click then Print button.  To print from Netscape select Print from 
the File menu, select Properties, then Layout change the orientation to Landscape, if your printer 
allows select legal t print on legal size paper,  then click the Print button.   

This Time In/Out Section is seen 
by Hourly employees only. 
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Restart 

This feature will clear your un-submitted time sheet of all data entry.  Use this if you find you have 
made several errors in entering your time and you wish to begin again from scratch.  

 

Comments 

You may enter and save comments by clicking on the Comments button at the bottom of the time 
sheet.  Comments are submitted along with your time sheet to your supervisor. 

 
 
Time Sheet Status Codes 
 

Time Sheet Status Description Allowable action 
Not Started Time sheet is unopened. Open Time Sheet to begin time 

entry.. 
In Progress Time sheet has been opened 

and time entry has begun. 
Enter, edit or review time.  
Submit time sheet. 

Pending Time sheet has been submitted 
and is waiting approval 

View only. 

Approved Time is approved. View only. 
Completed Time sheet has been 

downloaded to payroll. 
View only. 

Return for Error Correction Approver returned time sheet 
for error correction.. 

Correct time entry, re-submit 
time sheet. 

 
 
Transaction Status 
 

 
A time sheet’s status is displayed next to the pay period dates on the Position Selection page.  Only a 
time sheet status of  Not Started, In Progress or Returned for Correction allow time entry.  For all 
other statuses the time sheet is view only.  Below is a complete listing of time sheet statuses and the 
actions available for each status. 
Status Description Available Action 
Not Started A new time sheet that has not 

been opened. 
Enter time.  Submit time sheet 
for approval 

In Progress Time sheet has been opened. Enter time.  Submit time Sheet 
for approval 

Time sheet status. 
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Pending Time sheets is submitted and 
awaiting approval 

View time only. 

Returned for Correction Approver returned time sheet 
to you for correction. 

Make corrections. Re-Submit 
time sheet for approval.  

Error Time was not loaded properly 
into the Banner System 

Contact your time sheet 
approver. 

Completed Time sheet was processed 
through the payroll system. 

View only.  Completed time 
sheets may be viewed for the 
two previous pay periods. 

 


